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A Legal Professional’s Guide to PDF Files 
 

I. INTRODUCTION: 

A. PDF (Portable Document Format) Files: PDF is a file format that captures all 
elements of a printed document as an electronic image that you can view, 
navigate, print, or forward to someone else.  PDF files are created using Adobe 
Acrobat, Acrobat Capture, or similar products.  To view and use the files, you need 
the free Adobe Reader, which you can easily download for free (www.adobe.com).  
Once you've downloaded the Reader, it will start automatically whenever you 
want to look at a PDF file.  PDF files have become the de-facto standard method 
for distributing electronic forms on the Internet.   

B. A Little History: PDF started off on the dream of a paperless office, as the pet 
project of one of Adobe's founders, John Warnock.  Initially it was an internal 
project at Adobe to create a file format so documents could be spread throughout 
the company and displayed on any computer using any operating system. In his 
paper which led to the development of PDF, John Warnock wrote: 'Imagine being 
able to send full text and graphics documents (newspapers, magazine articles, 
technical manuals etc.) over electronic mail distribution networks. These 
documents could be viewed on any machine and any selected document could be 
printed locally. This capability would truly change the way information is 
managed.'  Warnock's prediction proved prescient.   

The first time Adobe actually talked about this technology was at a Seybold 
conference in San Jose in 1991. At that time, it was referred to as 'IPS' which stood 
for 'Interchange PostScript.' Version 1.0 of PDF was announced at Comdex Fall in 
1992 where the technology won a 'best of Comdex' award. The tools to create and 
view PDF-files, Acrobat, were released on June 15, 1993.  

If you think Adobe Acrobat is expensive today, keep in mind what Adobe originally 
charged for tools to create PDF files. Acrobat Distiller was available in personal 
and network versions, priced at $695 and $2,495 respectively. You even had to 
pay $50 for Adobe Reader. This approach didn't exactly turn PDF into a popular 
format overnight. Later on, Adobe dropped the price of Acrobat and launched the 
free version of Adobe Reader. 

C. PDF Released As Open Standard:  On July 1, 2008, Adobe released PDF as an open 
standard to be published by the International Organization for Standardization as 
ISO 32000-1.  Also in 2008, Adobe released a Public Patent License to ISO 32000-
1 granting royalty free rights for all patents owned by Adobe that are necessary to 
make, use, sell and distribute PDF compliant applications. 
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"'By releasing the full PDF specification for ISO standardization, we are 
reinforcing our commitment to openness', says Kevin Lynch, Chief 
Technology Officer at Adobe. 'As governments and organizations 
increasingly request open formats, maintenance of the PDF specification 
by an external and participatory organization will help continue to drive 
innovation and expand the rich PDF ecosystem that has evolved over the 
past 15 years.'"1 

D. What Is PDF/A?  PDF/A (archival PDF) is a type of PDF that is used for the long 
term storage of documents. Standard PDF files rely on external information, such 
as font libraries, to be read, and this can pose problems for retrieval far in the 
future. PDF/A files, on the other hand, have all information embedded in the file 
and do not rely on external information. This is useful for archiving, as anyone with 
a PDF/A reader can view a PDF/A file without the need for appropriate external 
information. The drawback to this is that because all information must be 
embedded in PDF/A files, they tend to be larger than regular PDF files.2  For a more 
detailed description of PDF/A, see the description provided by the Sustainability 
of Digital Formats Planning for Library of Congress Collections here:  
http://tinyurl.com/4wfwazy.  PDF/A matters to you because many of the 
electronic case filing systems require PDF/A or may require it in the future. 

E. Why Lawyers Are Using PDFs: 

1. Worldwide Standard: PDFs have become the worldwide standard for the 
distribution of electronic documents.  Since they are so common, it's 
extremely uncommon for the recipient of a PDF to be unable to open it. 

2. Protect the Document: Adobe Acrobat allows you to protect a document 
so that the text cannot be altered.  You can also control who may access 
it, whether it can be printed or opened, etc. 

3. Collaboration: Today, Adobe Acrobat makes it easy to solicit feedback, 
comments and proposed changes to a PDF document.  This makes PDFs 
ideal for negotiating the language of a documents and the like. 

4. Easy Creation: You can create PDFs from any computer program that will 
print (Word, WordPerfect, etc.).  You can also create PDFs with a scanner. 

5. Easy Combination: PDFs can be compiled from many sources and any PDF 
can be combined with another. 

                                                      
1 PDF Format Becomes ISO Standard, July 2, 2008.  See http://tinyurl.com/nbmbcrz. 
2 What Is PDF/A? CVISION Technologies, Inc.  See http://tinyurl.com/lxqnsag 

http://tinyurl.com/4wfwazy
http://tinyurl.com/nbmbcrz
http://tinyurl.com/lxqnsag
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6. Forms: Adobe Acrobat Professional allows you to create your own fillable 
forms; and makes it easy to collect the data that is entered into them. 

F. Microsoft Office and Acrobat Integration:  Acrobat has a slick integration with 
Microsoft Office (adds buttons and makes creating PDFs easier), but not every 
version of Acrobat integrates with every version of Office.  Even if you don't have 
versions of Office and Acrobat that integrate, you can still create PDFs from within 
MS Office by following the steps described in paragraph VI.A. below.  You just 
won't be able to create PDFs in the manner described in paragraph VI.B. below.  
Here are the versions that integrate: 

1. Acrobat 8 is compatible with MS Office 2003 

2. Acrobat 9 is compatible with MS Office 2003 & 2007 

3. Acrobat X is compatible with MS Office 2003, 2007 & 2010 

4. Acrobat XI and DC is compatible with MS Office 2003, 2007, 2010 & 2013 

II. TOOLS FOR CREATING PDFS: 

A. Basic Types of PDFs: There are two basic types of PDFs – Image Only and 
Searchable. 

1. Image Only PDFs: This type of PDF is visually an exact replica of the original 
document (whether the original document was electronic or paper-based), 
but it contains no text which could be searched by Acrobat or any other 
program.  This is usually the type of PDF that you get when you scan a 
document using a copier, scanner or multifunction machine. 

2. Searchable PDFs: This type of PDF is also an exact replica of the original 
document, but it also contains a hidden layer of text so that you can search 
for any word on any page.  PDFs created from other computer programs 
electronically are searchable by default.  In other words, if I create a PDF 
from a Word or WordPerfect document, an Excel workbook or an email, 
they are always searchable.  As mentioned above, PDFs created by 
scanning can be, but are not always searchable.  The software you’re using 
to scan will determine whether you can create searchable PDFs.  So that 
you can easily find the PDF documents you’re looking for, you want to use 
searchable PDFs. 

B. What Can Be Converted To A PDF: If you have the right hardware and software, 
you can create PDFs from just about anything, including electronic files (Word, 
WordPerfect, PowerPoint, Excel, etc.), paper documents, web pages, email, even 
something you’ve copied to your computer’s clipboard.  
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C. Programs You Can Use: In order to create PDFs from anything, you’ll need the 
appropriate software.  There are far more than I’ve listed below, but the following 
are probably the most popular options. 

1. Adobe Acrobat Pro DC:  There are two flavors here:  Acrobat DC Pro "with 
services" which you can only rent; and Acrobat DC Pro desktop which you 
can buy.  You can rent DC Pro with Services for $179.88/year or 
$24.99/month; and you can buy DC Pro Desktop for $449.  Only Pro is 
available for the Mac.  See http://tinyurl.com/ogympca for pricing and 
product information. 

2. Adobe Acrobat Standard DC:  There are two flavors here:  Acrobat DC 
Standard "with services" which you can only rent; and Acrobat DC Sandard 
desktop which you can buy.  You can rent DC Standard with Services for 
$155.88/year or $22.99/month; and you can buy DC Standard Desktop for 
$299.  Standard is not available for the Mac.  See 
http://tinyurl.com/ogympca for pricing and product information. 

3. Foxit PhantomPDF for Business:  Very strong feature match with Acrobat 
Pro for $129.  Also includes a 30 day free trial.  For more information, see 
http://tinyurl.com/7ybcjwu. 

4. Nitro Pro:  Matches the features of Acrobat Professional.  They offer a 
Nitro Pro+ which is rental only for $7.99/month ($95.88 paid annually - no 
option to pay monthly) and Nitro Pro (desktop) which is $159.99.  You can 
buy it here: https://www.gonitro.com/pro/for-you. 

5. Nuance Power PDF Advanced:  Matches features of Acrobat Professional 
for only $149.99.  See http://tinyurl.com/zwy2ym9.   

6. Foxit PhantomPDF Standard:  Strong match with Acrobat Standard for 
$89.  Free trial - for more information, see http://tinyurl.com/p3znuj3. 

7. pdfDocs Pro by DocsCorp:  Very strong feature match with Acrobat 
Professional and recently completely revamped.  A 12 month subscription 
is the only way to buy it and it's $107 annually.  See 
http://tinyurl.com/htz5s7d for more information. 

8. PDF-XChange Pro:  Fantastic product only missing redaction compared to 
Acrobat Pro.  Only $79.50 - see http://tinyurl.com/3ukmgr5. 

9. pdfFactory or pdfFactory Pro - $49 and $99, respectively - see 
www.fineprint.com 

10. Scan2PDF - $49 - www.burrotech.com/scan2pdf.php 

http://tinyurl.com/ogympca
http://tinyurl.com/ogympca
http://tinyurl.com/7ybcjwu
https://www.gonitro.com/pro/for-you
http://tinyurl.com/zwy2ym9
http://tinyurl.com/p3znuj3
http://tinyurl.com/htz5s7d
http://tinyurl.com/3ukmgr5
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11. PDF995 - free - www.pdf995.com 

12. PDFCreator - free - http://sourceforge.net/projects/pdfcreator 

13. CutePDF Writer from Acro Software - free - www.cutepdf.com 

14. WordPerfect - all versions - included for free 

15. Microsoft Word 2007, 2010, 2013 & 2016 - included for free 

D. Recommended Software: There are obviously many choices of programs that will 
allow you to create PDFs.  It is becoming more difficult every year to justify the 
price premium Adobe Acrobat charges over its competitors.  Having said that, 
Adobe invented PDF and Acrobat is arguable the most feature rich option.   

E. Acrobat Version Differences:  A matrix of the features of Acrobat DC is attached 
as Exhibit A on page 92.  A comparison of Acrobat X, XI and DC is attached as 
Exhibit B on page 93. 

F. Recommended Scanners: Here are a few scanners we particularly like. 

1. Basic Scanners Types: 

a. Flatbed Scanners: A flatbed scanner consists of a flat surface on 
which you lay documents to be scanned.  They're very similar to a 
copier in appearance and they're particularly effective for bound 
documents.  You can buy flatbed scanners with or without an 
automatic document feeder ("ADF").  However, buying one 
without an ADF is a complete waste of money as it will take an 
inordinately long time to scan any multi-page document.  No one 
will like it and no one will use it.  A flatbed scanner with an ADF will 
allow you to scan regular cut sheets of paper or bound materials.  
However, they’re generally slower and more expensive than their 
sheet-fed counterparts (see below). 

b. Sheet-Fed Scanners: Sheet-fed scanners lack the flat glass surface 
for scanning bound materials; and they only have an automatic 
document feeder.  However, sheet-fed scanners are generally 
faster and less expensive than flatbed scanners.  Of course, if the 
only type of scanner you have is a sheet-fed scanner and you need 
to scan bound materials, you could always copy the appropriate 
pages and then scan them. 

2. Recommended Flatbed Scanners:  If you must be able to scan bound 
documents (books or magazines), then you'll need a flatbed scanner.  
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Otherwise, go with a sheet-fed scanner (recommendations follow this 
paragraph). 

a. Xerox DocuMate 3220:  Scans 23 ppm, has a 50 sheet ADF and will 
scan color, b&w, and gray scale.  $308 from www.amazon.com - 
Mnfg. Part #XDM32205M-WU.  Part number is the same in Canada, 
but the price is $510 from www.amazon.ca. 

b. Fujitsu Fi-7260 Scanner: Scans b&w one-sided (simplex) at 60 

pages per minute or double-sided (duplex) at 120 pages per 
minute.  Also capable of color scanning; and handles letter or legal 
sized paper.  Part number PA03670-B555, $1,284 from 
www.pcnation.com.   

c. Fujitsu Fi-7280 Scanner: Scans b&w one-sided (simplex) at 80 

pages per minute or double-sided (duplex) at 160 pages per 
minute.  Also capable of color scanning; and handles letter or legal 
sized paper.  Part number PA03670-B505, $1,920 from 
www.pcnation.com.   

3. Recommended Sheet-Fed Scanners: 

a. Fujitsu ScanSnap iX500 Sheet-Fed Scanner: Sheet-fed, scans 25 
ppm simplex, 50 ppm duplex, no TWAIN driver, but comes with 
Adobe Acrobat X Standard and works fine with it.  This scanner is 
both Windows and Mac compatible.  The US mnfg. part number is 
PA03656-B005 and it costs $420 from www.pcnation.com.  The 
Canadian part number is PA-03656-B002 and it costs CDN$498 
from www.amazon.ca. 

b. Canon imageFORMULA DR-C225:  Sheet-fed, scans 25 ppm 
simplex, 50 ppm duplex, TWAIN compliant, 30 sheet feeder, USB 
2.0.  US & Canadian Part number 9706B002 and it costs $400 from 
www.amazon.com and CDN$584 from www.pc-canada.com. 

c. Canon imageFORMULA DR-C130:  Sheet-fed, scans 30 ppm 
simplex, 60 ppm duplex, TWAIN compliant.  USB 2.0 and TWAIN 
compliant.  The US & Canadian part number is 6583B002 and it 
costs $510 on www.amazon.com and CDN$663 from www.pc-
canada.com. 

d. Fujitsu Fi-7160 Sheet-Fed Scanner:  Up to 60 ppm/120 ppm duplex 
black and white or grayscale.  Rapid power up time in less than 4 
seconds; large capacity 80 page feeder; plastic and embossed 
credit card scanning; long document support up to 18.3 feet; scan 
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sticky notes, taped receipts, and labels while securing against 
multifeeds; innovative acoustic paper protection; Interactive, 
Multi-Line LCD Panel; Auto rotation, Auto size, Blank page removal, 
Auto color detection, and Assisted scanning features; TWAIN and 
ISIS drivers  The US part number is PA03670-B055, and it's $875 
from www.amazon.com; the Canadian part number is PA03670-
B052 and it's $894 from www.pc-canada.com. 

e. Fujitsu fi-7180 Sheet-Fed Scanner: Up to 80 ppm/160 ppm duplex 
black and white or grayscale.  Rapid power up time in less than 4 
seconds; large capacity 80 page feeder; plastic and embossed 
credit card scanning; long document support up to 18.3 feet; scan 
sticky notes, taped receipts, and labels while securing against 
multifeeds; innovative acoustic paper protection; Interactive, 
Multi-Line LCD Panel; Auto rotation, Auto size, Blank page removal, 
Auto color detection, and Assisted scanning features; TWAIN and 
ISIS drivers  The US part number is PA03670-B005, and it's $1,514 
from www.amazon.com; the Canadian part number is PA03670-
B002 and it's $1,429 from www.pc-canada.com. 

III. THE ACROBAT X AND XI INTERFACE: 

A. Main Window:  The main window has 5 different sections: Menu, Toolbars, 
Navigation Pane, and Task Pane. 
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B. Main Functionality of Each Section: 

1. Menu:  Open, Close, Send, Create PDFs, Security, Find, Search and Views. 

2. Toolbars: Quick access to PDF functions, can add or remove commands. 

3. Navigation Pane: Thumbnails, Bookmarks, Attachments. 

4. Task Pane: Contains all PDF functions and commands. 

5. Document Pane: Displays PDF. 

C. Customizing the Interface: 

1. Quick Tools Toolbar:   
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Icons can be added to the Quick Tools Toolbar by either:  

a. Clicking the configure button and adding commands via the dialog 
box 

 

or 

b. Dragging and dropping icon from the Task Pane to the Quick Tools 
Toolbar.  To drag an icon, you must use the handle on the icon: 
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2. Customizing the Task Pane:  To show the different groups of PDF functions 
and commands in the Task Pane either: 

a. On the menu, click View  Tools 

 

or 
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b. Click on the options at the top of the Task Pane: 

 

3. Tool Sets:  At the upper right hand corner of the screen is the Customize 
button.  Click this button and select "Create New Tool Set" to save a 
configuration of Task Pane Controls and Quick Tools Toolbar.  You can save 
multiple sets and switch between them. 

 

Choose "Manage Tool Sets" to rename, delete, import or export tool sets. 
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IV. THE ACROBAT DC INTERFACE:  Unfortunately, Adobe completely redesigned the Acrobat 
interface with version DC.  Here's what you need to know in order to follow the steps and 
instructions outline in the balance of this manual. 

A. Home Screen: When you first launch Acrobat, this is what you'll see.  It will show 
you recently used files and you can click on My Computer to browse to other 
folders and locate files to open. 

 

B. Document Screen:  When you open a PDF, you'll be in the document screen.  
Across the top of the screen, you'll see buttons for common tasks (print, email, 
etc.).  Here's what you need to know about this screen:   

1. In prior versions of Acrobat, there were buttons always visible for zooming 
in or out, selecting text and the like.  Now, the toolbar containing these 
functions (called the Page Controls toolbar) floats at the bottom of the 
screen and randomly disappears when Acrobat thinks you don't need it.   
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If you find the floating toolbar to be as annoying as I do, then you'll want 
to permanently attach it to the toolbar at the top of the screen.  You can 

do this by clicking the  button on the Page Controls toolbar when it 
appears (right side of toolbar).   

2. It's not obvious, but if you want to select text in a searchable PDF, then you 

have to click this button first:  (which is on the Page Controls toolbar). 

3. There is a Tools Pane on the right side of the screen that can be shown, 
hidden and very importantly, customized.  The Tools Pane presents you 
with a few tools by default but you can add whatever you would like.  First, 
if you don't see the Tools Pane, you can open it by clicking the right arrow 
in the middle of the right side of the screen.  It looks like this: 

 

You can also open it by hitting Shift+F4 or clicking the View menu  
Show/Hide  Tools Pane. 

Once the pane is open you can access tools by clicking the appropriate 
button.  Once you activate a tool, most of them will provide you with 
buttons that appear at the top of the screen.  For example, if I click on the 
Comment button, I see this: 
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If I want to close the comments environment, I can either click the 
Comment drop down (left side) and choose Back to Document; or I can 
click the X on the far, right-side of the screen. 

After you've clicked a tool button, it may not show you ALL of the available 
functions on the buttons that appear at the top of the screen.  Watch out 

for  buttons on the right edge of the toolbars and click them 
to see what might otherwise be concealed. 

C. Tools Screen:  If you want to control what tools appear in the Tools Pane, you 
need to go to the Tools screen.  You'll see all of tools available and if you click the 
add button below a tool, it will be added to your tools pane.  For example: 

 

D. Navigation Pane:  If you want to see the Navigation Pane, just hit F4 or click the 
View menu  Show/Hide  Navigation Panes  Show Navigation Pane.  This will 
allow you to easily see and browse thumbnails of the pages, bookmarks or 
attachments. 

V. VIEWING PDFS:  In addition to the main screen, Acrobat offers several other modes to 
view a PDF: 

A. Read Mode (CTRL + H):  Read Mode hides all the controls, except for the menu, 
on the screen and fills the window with the PDF.  Press the Escape Key to return 
to the main screen or toggle back and forth with CTRL+H. 

B. Full Screen Mode (CTRL + L):  Full Screen mode fills the entire computer screen 
with the PDF. Press the Escape Key to return to the main screen, or toggle back 
and forth with CTRL+ L.  This is important to remember with Acrobat DC because 



Page 15 

if you put it in full screen mode, the ONLY way to get it out of that mode is Ctrl + 
L. 

C. Read Out Loud:  If the PDF is text based or the text has been recognized, Acrobat 
can read the PDF using a built in speech synthesizer. To have Acrobat read a PDF: 

1. Click View  Read Out Loud  Activate Read Out Loud 

2. Click View  Read Out Loud  Read Page or Read To End of Document 

VI. ACROBAT PDF CREATION METHODS: 

A. Create PDFs from a Word Processor Using the PDF Printer Driver:  While this 
method certainly works and is easy, there are better alternatives below which 
create PDFs with bookmarks already in them. 

1. Open the word processing file that you want to convert to a PDF.  Note 
that nothing that you are doing will affect the underlying document. 

2. Click File from the menu bar, and then Print.  In the Print dialog box, you 
will have an option at the top to change the printer to which this print/save 
job will go. 

3. Change the printer to Adobe PDF and click the OK button. 

4. You will now be presented with a Save PDF File As dialog box.  Here, you 
must designate the folder into which you’ll deposit your PDF file and give 
it a name. 

5. You will shortly see a dialog entitled Creating Adobe PDF and a few 
seconds later, you will see the PDF you created which is viewed in Adobe 
Acrobat. 

B. Create PDFs Using PDFMaker Buttons in Word: As described in paragraph I.F. 
above, some version of Acrobat provide integrate with Microsoft Office.  In Word 
versions 2003 and prior, the integration creates new buttons in Word which look 
like this:  

 

The button on the left creates a PDF from the document you've opened in Word.  
The button on the right creates a PDF from the document on your screen and 
sends it for review (via email) to another party (via email).  The "send for review" 
button even adds instructions to the recipient on how to annotate the PDF and 
insert comments.   
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If you’re using Word 2007, you’ll see an extra tab on your ribbon and labeled 
buttons will appear if you click on the tab: 

 

If you're using Word 2010, you'll see this extra tab: 

 

In you're using Word 2013, you'll see this tab: 

 

The big benefit of using these buttons rather than the method outlined in 
paragraph VI.A. above is that if you have used Styles in your source Word 
document, automatic paragraph cross references, auto-generating tables of 
contents and the like3, Acrobat automatically sets up hyperlinks so your resulting 
PDF is interactive (and searchable) and PDF Bookmarks are created for all Heading 
styles in the source Word document (see paragraph XVIII.A. on page 60). 

C. Create PDFs Using Word's Native PDF Maker:  If you have Word 2007 (Service 
Pack 2), Word 2010, 2013 or 2016, then you can create PDFs without buying 
Acrobat or installing anything else.  Simply open the document for which you want 
to create a PDF, then click the Office Button (2007)/File menu (2010/13/16)  
Save As  click the drop down menu adjacent to "Save as type" and choose PDF 
(*.pdf).  Note that this has no impact on the original document and does not save 
it so you need to do that separately. 

                                                      
3  If you don’t know how to use any of those features in Word, we can provide training for you.  Just contact Barron 
Henley at bhenley@affinityconsulting.com. 



Page 17 

 

Also note that if you click the OPTIONS button in the dialog above, you can create 
bookmarks using Word's heading styles or plain Word bookmarks. 

 

D. Create PDFs Using WordPerfect's Native PDF Maker:  Open the documents for 
which you want to create a PDF  click the File menu  Publish to PDF. 

E. Create PDFs from Outlook With Acrobat Integration: Acrobat also installs a few 
buttons and one additional menu in Microsoft Outlook.  For those that wish they 
had a good way to archive and store emails and attachments, this integration can 
be a life-saver.  The Outlook 2003 & 2007 integrations create new menus in 
Outlook: 
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In Outlook 2010/13/16, the integration creates a new tab that looks like this: 

 

1. Creating PDFs from Individual Emails or Entire Folders: With Acrobat 9, 
simply select individual emails (Ctrl+left click) or select entire folders; then 
click the Adobe PDF menu  Convert to Adobe PDF and then the 
appropriate sub item.  With the combination of Acrobat X/XI and Outlook, 
select the appropriate emails or entire folders, then click the Selected 
Messages or Selected Folders button from the Adobe ribbon in Outlook.  
This will create a single PDF which contains all of the emails you’ve selected 
and all of the attachments thereto.   

2. Adding Subsequent Emails to Existing PDFs: If you receive additional 
emails which need to be added to an existing PDF archive, simply choose 
Convert and Append to Existing Adobe PDF. 

3. Automatic Archival: As you can see from the screen shot above, you can 
also setup folders to automatically archive themselves.  This would be 
particularly useful if you have setup Outlook rules to automatically sort 
your email into specific folders and then use Acrobat to automatically 
archive it. 
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F. Create PDFs from Within Acrobat: With Acrobat 9, this is as easy as clicking a 
button (Create).  Once you click the button, you'll be presented with options: 
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In Acrobat X/XI, the menu is slightly different:   

 

In Acrobat DC, the menu is also slightly different: 

 

Choose the appropriate option and Acrobat walks you through the rest of the 
steps. 

G. Create PDF from Web Page: According to Acrobat’s help, a PDF that you create 
from a web page is only as accessible as the HTML source that it is based on.  For 
that reason, you may not want to create a PDF using Create PDF  From Web 
Page.  Some images may not print and some hyperlinks may not be active.  
Therefore, if you want to make a PDF out of a web page, try this method and the 
method described in paragraph VI.A above to see what yields a better result.  
Before you make a PDF from a web page using the PDF printer driver, make sure 
you look for a PRINT button somewhere on the web page itself (rather than in 
your browser).  This will normally clean up what you're trying to create a PDF from 
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and take out much of the advertising and other non-story related items on either 
side of what you want. 

H. Create PDF from Scanner: If you have a TWAIN or WIA compliant scanner 
connected to your computer, then you can create PDFs from paper documents.  
Just follow these steps: 

1. In Acrobat X or XI, click the Create PDF button or in DC, click the File menu 
 Create, then choose "From Scanner..." 

2. In the Input section, choose your scanner.   

 

3. In the Output section, choose "new" or you "append" if you want to add 
this PDF to an existing one.   

 

4. The PDF/A reference in the above screen-shot refers to a standard defined 
by the International Organization for Standardization (ISO). PDF/A refers 
to long-term archiving of electronic documents. During PDF conversion, 
the file that is being processed is checked against the PDF/A standard. If 
the PDF will not meet the selected ISO standard, a message appears, asking 
you to choose between canceling the conversion or going ahead with the 
creation of a non-compliant file. 
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5. In the Document section of versions X or XI, make sure you check "Make 
Searchable..." so that the text inside the PDF can be searched. 

 

In DC, the Document Settings are a bit different and you want to check 
"Recognize Text." 

 

6. Click the Scan button, save the PDF and you’re done. 

I. Converting to PDF/A:  If you need to convert an existing PDF to PDF/A for 
electronic case filing, open the PDF you want to convert in Acrobat and follow 
these steps: 

1. Acrobat X:  Click File menu  Save As  More Options  PDF/A. 

2. Acrobat XI & DC:  Click the File menu  Save As Other  Archivable PDF 
(PDF/A) 

VII. CONVERTING IMAGE ONLY PDFS INTO SEARCHABLE PDFS:  When you scan documents 
into PDFs, they are image-only PDFs (see paragraph II.A.1. above).  If you want to be able 
to find them in the future by the text they contain, then they'll have to be converted to 
searchable PDFs. 

A. One PDF At A Time: You can make this conversion one PDF at a time by opening 
the PDFs in Acrobat Standard or Professional.  Just follow these steps:   
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1. Open the PDF you want to make searchable. 

2. In Acrobat 8 or 9, click the Document menu  OCR Text Recognition  
Recognize Text Using OCR. 

In Acrobat X/XI, click the Tools button  Recognize Text  In This 
Document. 

 

In Acrobat DC, open the Enhance Scans tool (from the Tools menu or the 
Tools pane)  Recognize Text  In This File.  You can also accomplish this 
by using the Enhance button in the same toolbar. 

 

3. In Acrobat X & XI, just click OK in the next dialog.  In DC, click the Recognize 
Text button. 

B. Importance of ClearScan in Acrobat 9, X & XI:  You can vastly improve the quality 
of scanned documents and reduce the PDF file size by turning on ClearScan in the 
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PDF Output Style when converting image-only PDFs to text-searchable PDFs.  To 
do this, in the Recognize Text dialog, click Edit and then ClearScan in the PDF 
Output Style field.  Click OK and OK again.  This setting will remain for future OCR 
conversions until you change it again. 

  

To appreciate what ClearScan can do, below is a screen shot of some text scanned 
at 300 dpi in an image-only PDF zoomed in 1,000%. 
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Here is the same text after the PDF was made searchable using ClearScan.  As you 
can see, the difference is dramatic. 

 

In order to confuse people unnecessarily, Adobe renamed ClearScan in the DC 
version to "Editable Text and Images." 

 

C. Batch Processing to Searchable PDF in Acrobat 9: If you have a folder of image-
only PDFs and you need to convert them to searchable PDF, you can do this in bulk 
using Acrobat's Batch Processing feature.  Just follow these steps: 

1. Select Advanced from the menu bar, Document Processing and then Batch 
Processing. 

2. Select New to create a new Batch Sequence.  Call it something like 
"Convert to Searchable " and click OK. 

3. Click on Select Commands, then choose Recognize Text Using OCR and click 
the Add button, then click OK. 
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4. Under Run commands on, choose Selected Folder and then click Browse 
to select the desired folder containing the PDFs to convert. 

 

5. Under Select output location, choose Same Folder as Original(s). 

6. Now click the Output Options button.  If you want to over-write the 
existing PDFs with new searchable PDFs, choose Same As Original(s) under 
File Naming.  If you want to create new names, choose Add to Original Base 
Name(s), add a prefix or suffix and check Do not overwrite existing files.  In 
any event, uncheck Fast Web View (PDF Only) and make sure the Save 
File(s) As selection is set to Adobe PDF Files. 
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7. Click OK, OK and Close. 

8. If you want to run the batch sequence, simply the Advanced menu, then 
Document Processing, then Batch Processing.  Choose your batch 
sequence, then click Run Sequence, then click OK. 

NOTE:  This process can take a while so don't be alarmed. 

D. Batch Processing to Searchable PDF in Acrobat X/XI: Just click the Tools button 
 Recognize Text  In Multiple Files.  Browse to the documents you want to OCR 
and click OK.   

E. Batch Processing to Searchable PDF in Acrobat DC:  Click the Enhance Scans tool.  
If you have a PDF already open, you can choose the Recognize Text button  In 
Multiple Files.  Identify the files and click OK.  If there are no PDFs open, then in 
the next screen, choose "Or recognize text in multiple files" to initiate the process. 
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VIII. COPYING TEXT OUT OF A PDF: 

A. PDF Must Be Searchable In Order to Copy Text: In order to copy text from a PDF, 
the PDF must not be secured or locked down and it must be a searchable PDF.   

B. Copy Text From a PDF and Insert into Word Processor: 

1. If your PDF is searchable and not otherwise secured, then you can use the   

 or  button to select text (hold down on your left mouse button 
and drag).  Once the text is selected, you can click Edit and then Copy, then 
you can go into a Word or Word Perfect document and click Edit and then 
Paste.   

2. If you don't have any text in your PDF, you can use OmniPage Pro to pull 
out the text or Adobe’s Convert to Text/OCR feature. 

C. Convert PDF to Word Processor Document: If you're using Acrobat X or XI, open 
the PDF you want to convert in Acrobat.  Click the File menu  Save As Other  
Microsoft Word  Word Document.  If you're using Acrobat DC, then click the File 
Menu  Export To  Microsoft Word  Word Document. 

IX. SNAPSHOT TOOL: 

A. Acrobat Versions:  The snapshot tool is available in Adobe Reader and Adobe 
Acrobat (Standard and Professional) versions 9, X, XI and DC. 

B. Taking a Snapshot of a PDF:  If you want to capture part of a PDF as an 
image/picture so you can insert it into a Word document or PowerPoint 
presentation, for example, this is easily accomplished using the Snapshot tool in 
Adobe Acrobat.  This is useful for including a paragraph of another document in a 
letter you’re drafting.  For example, if I were discussing a certain paragraph (not 
as text, but instead as an image) of a lease my client signed, I could literally insert 
a snapshot of the paragraph into the letter I am drafting rather than re-typing it.  
To take a snapshot, just follow these steps: 

1. In Acrobat 9, click the Tools menu  Select and Zoom  Snapshot Tool.  In 
Acrobat X, XI and DC, simply click the Edit menu  Take a Snapshot. 

2. Hold down on your left mouse button and draw a box around the text in 
the PDF you’d like to take a snapshot of.  Once you release the mouse 
button, the section of the PDF you drew the box around is now on your 
clipboard. 
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3. Go into Word, WordPerfect or PowerPoint and simply paste (Ctrl + V) the 
snapshot into your document or presentation. 

C. Great Uses For This Feature: 

1. Inserting image clips of text into letters and pleadings. 

2. Inserting image clips of text (statutes, contract provisions, deposition 
answers, etc.) into PowerPoint presentations. 

3. Inserting deposition answers into a witness exam outline for trial 

X. ADDING COMMENTS AND MARKUP TO PDFS: 

A. Requirements: In order to comment on PDFs and annotate them, you must have 
Adobe Acrobat Standard or Professional.  However, if you have Acrobat 
Professional, you can create PDFs that will allow recipients with nothing more than 
the free Adobe Reader to comment on and annotate your PDFs. 

B. Enable Usage Rights in Adobe Reader: If you have Acrobat Professional version 8 
or 9, then once you’ve created a PDF and it is open in Acrobat, you can give Adobe 
Reader users full annotation rights by clicking the Advanced menu  Enable Usage 
Rights in Adobe Reader. 
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You’re next presented with this dialog: 

 

Simply click Save Now and you are ready to send it to someone else. 

If you have Acrobat Professional X or XI, then click the File menu  Save As  
Reader Extended PDF  Enable Additional Features  Save Now.  In DC, click the 
File menu  Save As Other  Reader Extended PDF  Enable More Tools. 

C. Add Suggested Text Edits to a PDF: 

1. First, open the PDF you want to annotate, click the  or  button 
(depending upon your version) and then select the text in the PDF you 
want to annotate. 

2. In Acrobat 9, click the Text Edits button and choose an option.  As you can 
see, there are plenty of choices! 
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3. In Acrobat X and XI, click the Comment button on the far right side of the 
screen.  In Acrobat DC, click the Comment tool which will reveal the 
following toolbar. 

 

D. Other Annotations: 

On the same toolbars in all versions of Acrobat (see the previous paragraph 
regarding how to access the toolbar), there are buttons for the following things: 

1. Sticky notes 

2. Stamps (for example, DRAFT, SIGN HERE, etc.) 

3. Highlighting text 

4. Creating Callouts 

5. Text boxes 

6. Clouds (squiggly boxes) 

7. Arrows 

8. Lines 

9. Boxes 

10. Circles 

11. Pencil (draw free-hand) 
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12. Attach files - you can insert other files (such as a Word file) into a PDF.  It 
appears as an icon and if you double click it, the original file will open in its 
original format (it is not converted to PDF).  An attached file icon looks like 

this:  

13. Record audio - you can record voice messages and attach them to the 

document.  An attached audio file icon looks like this:   

E. Getting Annotations to Print: When you print a PDF with annotations, you need 
to do two things to make sure they all appear on the printed version.  First, you 
need to go into Acrobat’s Preferences (Edit menu  Preferences), then click on 
Commenting  check "Print notes and pop-ups."  Why this isn’t checked by 
default, I cannot imagine, but it isn’t. 

 

F. Printing Annotations: One would logically assume that if you print a PDF with 
comments and/or annotations, those annotations would show up on the printed 
copy.  Well, one should never assume!  However, Acrobat has excellent options 
for printing annotations and comments. 

1. Printing Document Options: When you click the Print button in Acrobat, 
you’ll get the standard print dialog.  At the top of that dialog, you’ll see a 
"Comments and Forms" setting.  Click the down-arrow below it and you’ll 
see your options.  However, this will NOT provide you with a print out of 
inserted text, substitute text or the contents of comment or sticky notes.  
In order to get those things, see the next paragraph. 



Page 33 

 

2. Printing Comment Summaries: If you want to print all of the annotations, 
you have several options.  First, click the Print button (or Ctrl+P).  At the 
bottom of that dialog, you’ll see a Summarize Comments button.  In 
Acrobat 8, 9 & XI, when you click Summarize Comments, you’ll see all of 
your options for printing the comments.  They include: 
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Once you’ve chosen the option you want, click the Print Comment 
Summary Button, then OK in the subsequent dialog. 

In Acrobat XI and DC, you don't get the foregoing options.  Instead, it will 
only produce the annotations in the last format shown above: "Documents 
and comments with sequence numbers on separate pages." 

G. Show or Hide Annotations: By clicking the Show button on the Comment and 
Markup toolbar, you can filter or display the annotations by almost any criteria 
you’d like: 

 

H. Adding Text to a PDF:  The Adobe typewriter is an excellent tool to replace the old 
giant typewriters sitting around taking up space around your office.  This feature 
allows you to type anywhere you want on a PDF (it doesn't matter whether it is 
fillable).  In Version 8 and 9, select View  Toolbars  Typewriter Tool.  In Version 
X/XI, to access this tool, select Tools  Content  Add or Edit Text Box.  The 
Typewriter toolbar will appear: 
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At this point, you can click and type on the PDF.  If you're using Acrobat DC, then 
click the Edit PDF tool  Add Text button  click in the open PDF document and 
type. 

XI. ROUTING PDFS FOR REVIEW BY OTHERS: PDFs are frequently what lawyers send to one 
another when negotiating a document.  They're not editable like a Word or WordPerfect 
document, they can be locked down and they effectively eliminate any compatibility 
issues since PDFs are universal.  If you've created a PDF that you want to send to someone 
else for review and comment, you have many options.  More importantly, the other 
parties to the review only need the FREE Adobe Reader version 7 or higher. 

A. Choose a Review Type: There are three types of reviews: 

1. Email Based Reviews: Email-based reviews are ideal for soliciting feedback 
from individuals who either don’t have access to your server (such as 
opposing counsel).  

In an email-based review, the drafter sends a PDF to reviewers as an email 
attachment. Reviewers can add comments (proposed changes, etc.) to the 
PDF and return the document to the originator by using the Send 
Comments button in either the Comment & Markup toolbar or the 
document message bar. When receiving these comments, the initiator can 
merge them into their copy of the PDF.  

The primary limitation to email-based reviews is that participants can’t 
view each other's comments during the review. Initiators can view 
comments only after receiving them. 

2. Shared Reviews: Shared reviews are best for groups that work behind a 
firewall and have access to a remote server. Shared reviews are the most 
collaborative form of review because participants can read and reply to 
each other's comments whether they review the PDF locally, as an email 
attachment, or on a remote server. Reviewers outside the firewall can also 
participate by sending their comments to a reviewer within the firewall, 
who then publishes them to the shared PDF.  

Of all the managed reviews, shared reviews provide the most detailed 
information about the active review. A notification feature lets you know 
when new comments are available, even when Acrobat is closed, and 
you’re informed of all recent review activity each time you open the PDF. 
Published comments are saved to the server and to the local hard drive, 
and Acrobat synchronizes comments between these two locations at 
regular intervals to download all the latest comments and changes.  
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3. Browser Based Reviews: Like shared reviews, browser-based reviews are 
suitable for collaborative groups with access to a shared server. Reviewers 
can view each other's comments during the review process. In a browser-
based review, the initiator uploads a PDF to the server and then sends an 
email invitation to reviewers. The email includes a setup file that, when 
clicked, opens the PDF in the default browser. Reviewers click the Send 
Comments button in the Comment & Markup toolbar to upload their 
comments, which are stored in a comments repository on the shared 
server.  

Browser-based reviews lack many of the advantages of shared reviews in 
terms of setup and tracking tools, and support for network folders. In 
addition, Acrobat must download all comments in the PDF each time you 
join the review, often a time-consuming process. For these reasons, Adobe 
recommends shared reviews as the preferred collaborative method. 

B. Send By Email For Review: In order to send a PDF for review by email, just follow 
these steps: 

1. Create PDF: It doesn't matter what method you use for creating the PDF in 
the first place.  This process is a bit easier if you open the PDF you want to 
send in Acrobat first, and then initiate.  However, you can also choose the 
PDF you want to work with after you initiate the process.  

2. Initiate Email Review Process: In Acrobat 9, you do this by clicking the 
Comment button, then choosing Attach for Email Review from the menu 
that appears.   

 

You are now presented with this screen.  If you have already opened the 
PDF you intend to work with, then it will be listed under "Specify a PDF...".  
Otherwise, you can choose the PDF you want to work with my clicking the 
Browse button.  After the PDF you want is identified, click the Next button. 

In Acrobat X and XI, you initiate the process by clicking the Tools button on 
the right side  Review  Send for Email Review. 
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In Acrobat DC, you initiate the process by clicking the Send for Comments 
tool  Send for Comments by Email button. 

 

3. Invite Reviewers: If you click the Address Book button, Acrobat will take 
you to the Outlook address book and you can easily choose email 
addresses for the recipients.  Otherwise, you can simply type email 
addresses in the window to the right of the Address Book button. 
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4. Preview Invitation: Now you'll be presented with the dialog shown below.  
You'll notice that the instructions for the recipient are already setup by 
Adobe Acrobat.  Click the Send Invitation button. 

 

5. Send Invitation: Once you click the Send Invitation button in the previous 
dialog, Acrobat will automatically send out an email to the recipient(s). 

When the recipient opens the attachment to the foregoing email, they'll 
see a full explanation in Acrobat of what you've initiated and how it works. 

The "Commenting" toolbar automatically opens and gives the user the 
option for adding notes, inserting text, deleting text, etc., even if the 
recipient doesn't own the full version of Adobe Acrobat.  After the 
recipient makes proposed changes, he/she can simply click the Send 
Comments button on the Commenting toolbar and Acrobat will attach the 
annotated PDF to an email and automatically send it back to you. 

6. Merge Comments: When the PDF shows up in your inbox, double-click it.  
You'll be presented with the screen below providing you options for 
merging the sender's comments into your master.   
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If the PDF you sent in the first place is still in the same location, you can 
add the sender's comments to your master with one click (or not).  So a 
very important aspect of an email review is that you can send the same 
PDF document to as many people as you want and have them review it 
independently.  Whenever they send back their comments, you can just 
merge them into your master PDF or save them as separate PDFs.  Later, 
you can merge them into your master if you'd like (you don't have to do it 
as soon as the annotated PDF shows up).   

Furthermore, if you decide not to merge the comments into the master at 
this point, you can always do it later by choosing "Merge Comments into 
Master PFD" from the Comments menu in Acrobat. 

C. Compare PDFs: If you have two different versions of a PDF document, you can use 
Acrobat to compare them to one another.  Note that this feature is available in 
Acrobat Pro only.  Just follow these steps: 

1. In Acrobat 9, click on the Document menu  Compare Documents; in 
Acrobat X/XI/DC, click the View menu  Compare Documents. 

2. You will see a dialog like this in which you need to select the documents 
you’re comparing and set your compare preferences.  My 
recommendation would be to show Textual Differences in a Side by Side 
Report.  You can experiment with the other settings, but I found these to 
render the most useful comparison report. 
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3. If you use the foregoing settings, you will be presented with a new 
document that identifies changes in the following manner: 
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XII. ELECTRONIC SIGNATURES USING THE STAMP TOOL: This is a way to add your signature 
to a PDF as an image.   

A. Steps for Using a JPG File:  This is easy because almost any scanner can produce 
JPG files.  However, there is a drawback with JPG files in that your stamp will have 
a white, square background.  Therefore, it will obscure anything behind it.  There 
is a way to avoid this problem, but it’s a little more complicated (see paragraph 
XII.B. below). 

1. Sign your name to a blank sheet of paper.  Scan it and save it as a JPG.  
Open it in Microsoft Picture Manager.  Select Picture and Crop.  Reduce 
the size of the JPG to be as small as possible and still include your signature.  
Click OK and then Save.  Note the location. 

2. From the Stamp Tool in the Comment and Markup Toolbar select the drop-
down menu and Create Custom Stamp. 
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3. Browse to the location of your saved signature from step one and change 
the "Files of type" designation at the bottom of the screen to JPG files.  
Open it and click OK.  Create a new category called Attorney Signatures or 
My Signatures and enter your name in the Name field.  Click OK. 

 

B. Steps for Using a PNG File:  The steps here are similar, but we’re using a PNG file 
rather than a JPG.  The benefit of doing this is that you can open a PNG file in 
Adobe Photoshop and remove the white background, thereby creating a signature 
stamp of the ink lines only.  As such, you can drop it on a PDF and it won’t obscure 
anything in the background with a big white square. 

1. Sign your name to a blank sheet of paper.  Scan it and save it as a JPG.  Now 
you need Adobe Photoshop, Adobe Photoshop Elements or Gimp4.  
Assuming you have Photoshop Elements, open Elements and crop it 

                                                      
4 Gimp is a free image editor program you can download from www.gimp.org. 
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(reduce its dimensions) and then save it as PNG5 file.  Select the white 
background and delete it, then save the file (note the location). 

2. From the Stamp Tool in the Comment and Markup Toolbar in Acrobat, 
select the drop-down menu and Create Custom Stamp. 

3. Browse to the location of your saved signature from step one and change 
the "Files of type" designation at the bottom of the screen to PNG files.  
Open it and click OK.  Create a new category called Attorney Signatures or 
My Signatures and enter your name in the Name field.  Click OK. 

XIII. FLATTENING PDFS:  If in a PDF you use the Typewriter tool, electronic signatures or any 
of the annotation tools described previously and send that PDF to someone who owns 
Acrobat Standard or Pro, they’ll be able to select your annotations, move or delete them.  
Flattening a PDF means to move these annotations into the main layer of the PDF so that 
they will always print and cannot be easily selected, deleted or moved.  There are two 
ways to flatten PDFs: 

A. Flatten By Printing to PDF Again:  If I have a PDF and have dropped my signature 
stamp onto it, I can flatten the signature by opening the PDF in Acrobat, clicking 
File menu  Print  choosing the Adobe PDF printer and creating another PDF 
from the PDF I just added my signature to.  Of course, this is creating multiple 
copies of the same PDF. 

B. Acrobat 9 - Flatten By Adding a Menu Item To Do This in Acrobat:  This works 
only in Acrobat 9 and requires a bit more work, but is much easier to use once it 
is completed.  For a full explanation of how this works, see Rick Borstein’s blog 
article on the subject at http://tinyurl.com/2eld56u.  Anyway, here are the steps: 

1. Exit Acrobat. 

2. Download the file flatten.js file from the foregoing blog article at 
http://tinyurl.com/2d3ptwx (see Step 2 of the instructions on that site). 

3. Store the file in C:\Program Files\Adobe\Acrobat 9.0\Acrobat\Javascripts. 

4. Re-launch Acrobat.  Under the Document menu, you should now see: 

                                                      
5 For more information on PNG files, see http://www.fileinfo.com/extension/png. 
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C. Acrobat X:  Flatten Form Fields and Comments Using Acrobat X Actions:  This 
works only in Acrobat X.  You can read the instructions here:  
http://tinyurl.com/7h7nx8s.  The steps are as follows: 

1. Download the Action (there is a link at the foregoing web site). 

2. Open the resulting PDF.  On the left side, you'll see an "attachment" called 
Flatten Fields and Comments.sequ.  Right click and save it on your desktop 
(don't rename it). 

3. Double click the attachment and click the Import button.  That's it. 

4. To use the feature, click on Tools>Action Wizard and you'll see an option 
to Flatten Fields and Comments. 

D. Flattening Fields Only Using Acrobat Professional:  If you have Adobe Acrobat Pro 
X or XI, then you can also flatten fields only by following these steps: 
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1. Open the PDF in Acrobat 

2. Click the File menu  Save As  Optimized PDF 

3. Uncheck all of the boxes on the left side of the subsequent dialog except 
"Discard Objects."  Click on Discard Objects and check only "Flatten form 
fields"  OK button. 

 

XIV. PDF ENCRYPTION AND SECURITY:  There are two types of encryption you can apply to a 
PDF if you have the Acrobat Standard or Professional:  Certificate Encryption and 
Password Encryption.  Certificate Encryption is too complicated for purposes of this 
seminar so we're going to focus on Password Encryption (which is very effective and much 
easier to apply).  To apply Password Encryption to your PDF, follow these steps: 

A. Warning About PDF Passwords: All Adobe products enforce the restrictions set 
by the Permissions password. However, because third-party products may not 
support or respect these settings, document recipients may be able to bypass 
some or all of the restrictions you set. 

Important: If you forget a password, there’s no way to recover it from the PDF. 
Consider keeping a backup copy of the PDF that isn’t password-protected. 

B. Password Encryption: In Acrobat 8 and 9, click the Secure button, then choose 
Password Encrypt from the menu that appears. 
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In Acrobat X/XI, click Tools  Protection  Encrypt  Encrypt with Password.  In 
Acrobat DC, click the Protect tool  Encrypt button Encrypt with Password. 

1. Set A Document Open Password: As you can see in the foregoing dialog, 
you can require a password before the PDF can even be opened.   

 

2. Restrict Permissions: 

 

a. Printing Allowed: This setting allows you to control whether users 
can print; and if so, what level of printing they're allowed.  Options 
include: 

i. None: Prevents users from printing the document. 

ii. Low Resolution (150 dpi):Users can print at no higher than 
150-dpi resolution. Printing may be slower because each 
page is printed as a bitmap image. This option is available 
only if the Compatibility option is set to Acrobat 5 (PDF 1.4) 
or later. 

iii. High Resolution: Lets users print at any resolution, directing 
high-quality vector output to PostScript and other printers 
that support advanced high-quality printing features. 

b. Changes Allowed: This setting controls which editing actions are 
allowed. 
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i. None: Prevents users from making any changes to the 
document, such as filling in form fields and adding 
comments. 

ii. Inserting, Deleting, And Rotating Pages: Allows users to 
insert, delete, and rotate pages, and create bookmarks and 
thumbnails. This is only available for high (128-bit RC4 or 
AES) encryption. 

iii. Filling in Form Fields and Signing Existing Signature Fields: 
This allows users fill in forms and add digital signatures. This 
option does not allow users to add comments or create 
form fields (only available for high encryption). 

iv. Commenting, Filling In Form Fields, And Signing Existing 
Signature Fields: Allows users to add comments, digital 
signatures and fill in forms. This option does not allow users 
to move page objects or create form fields. 

v. Any Except Extracting Pages:  Allows users edit the 
document, create and fill in form fields, and add comments 
and digital signatures. 

c. Enable Copying of Text, Images, and Other Content: This option 
allows users to select and copy the contents of a PDF.  

d. Enable Text Access For Screen Reader Devices For The Visually 
Impaired: This allows visually impaired users to read the document 

with screen readers, but doesn’t allow users to copy or extract the 
document’s contents (only available for high encryption).  

3. Choose Compatibility: Generally, the lower the version of Acrobat you 
choose for compatibility, the less secure your PDF will be.  However, be 
aware that anyone using an earlier version of Acrobat cannot open a PDF 
document with a higher compatibility setting. For example, if you select 
the "Acrobat 8 and Later" option, the document cannot be opened in 
Acrobat 7.0 or earlier.  My recommendation would be to make your 
compatibility version 8 or 9.  If someone is still using Acrobat 7 or prior, 
they can easily download the current version of Reader for free (and they 
should). 
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C. Security Envelopes: 

1. What They Are:  A security envelope is a way to take a group of otherwise 
unsecured electronic files and encrypt them in a secure container which 
can be opened with a password.   

2. How to Create A Security Envelope:  Just follow these steps: 

a. In Acrobat 9, click Advanced menu  Security  Create Security 
Envelope; or in Acrobat X/XI, click Tools  Protection  More 
Protection  Create Security Envelope; or in Acrobat DC, click the 
Protect tool  More Options button  Create a Security Envelope. 

 

b. Click the Add Files To Send button, browse to the files you want to 
include, select them and click the Open button.  Now click Next. 

c. Select an envelope template such as eEnvelope with Date Stamp 
and click Next. 

d. In the next dialog, choose "Send the envelope later" and click Next. 

e. Now you're at a dialog where you can select a security policy.  
Check the box that says Show all policies  choose Encrypt with 
Password  Next  Finish. 
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f. Now Acrobat will ask you for a password.  Check the box that says 
Require a password to open the document and enter the 
password in the box provided.  Click OK  OK.  The Security 
Envelope will now appear on your screen.  Customize it as you see 
fit. 

g. Click the Save button on the Acrobat Toolbar and it's ready to send! 
When the recipient tries to open your PDF, they'll have to enter the 
password you set up. 

 

3. Creating A Custom Envelope With Your Logo and Information On It:  This 
is a bit beyond the scope of this class, but it can definitely be done.  For 
instructions on how to do it, see Custom Security Envelopes by Rick 
Borstein which you can access here:  http://tinyurl.com/82j5kf7. 

XV. ELIMINATING PDF HIDDEN CONTENT:  People often mistakenly assume that PDFs have 
no metadata.  This is not true.  In fact, Acrobat 9, X, XI and DC all have a feature which 
allows you to easily find and remove hidden information from a document that you don’t 
want, such as hidden text, metadata, comments, and attachments.  If you want to 
examine your PDF, follow these steps: 

A. Steps for Acrobat 8 & 9: Click Document menu  Examine Document. If any 
hidden items are found, they are listed in the Examine Document dialog box with 
a selected check box beside each item.  Make sure that the check boxes are 
selected only for the items that you want to remove from the document. The 
following is an explanation of each item. 

1. Metadata: Metadata includes information about the document and its 
contents, such as the author’s name, keywords, and copyright information, 
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that can be used by search utilities. To view metadata, choose File menu 
 Properties. 

2. File Attachments: Files of any format can be attached to the PDF as an 
attachment. To view attachments, choose View menu  Navigation Panel 
 Attachments. 

3. Annotations And Comments: This includes all comments which were 
added to the PDF using the comment and markup tools, including files 
attached as comments. To view comments, choose View  Navigation 
Panel  Comments. 

4. Form Field Logic Or Actions: This item includes form fields (including 
signature fields), and all actions and calculations associated with form 
fields. If you remove this item, all form fields are flattened and can no 
longer be filled out, edited, or signed.  

5. Hidden Text: This option indicates text in the PDF that is either 
transparent, covered up by other content, or the same color as the 
background. To view hidden text, click Preview. Click the double arrow 
buttons to navigate pages that contain hidden text, and select options to 
show hidden text, visible text, or both.  

6. Hidden Layers: PDFs can contain multiple layers that can be shown or 
hidden. Removing hidden layers removes these layers from the PDF and 
flattens remaining layers into a single layer. To view layers, choose View 
menu  Navigation Panel  Layers. 

7. Bookmarks: Bookmarks are links with representational text that open 
specific pages in the PDF. To view bookmarks, choose View menu  
Navigation Panel  Bookmarks. 

8. Embedded Search Index: An embedded search index speeds up searches 
in the file. To determine if the PDF contains a search index, choose 
Advanced menu  Document Processing  Manage Embedded Index. 
Removing indexes decreases file size but increases search time for the PDF. 

9. Deleted Hidden Page And Image Content: PDFs sometimes retain content 
that has been removed and which is no longer visible, such as cropped or 
deleted pages, or deleted images. 

10. Select Items to Remove: Click Remove All Checked Items to delete 
selected items from the file, and click OK. When you remove checked 
items, additional items are automatically removed from the document: 
digital signatures; document information added by third-party plug-ins and 
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applications; and special features that enable Adobe Reader users to 
review, sign, and fill in PDF documents. 

11. Save File:  Choose File menu  Save, and specify a filename and location. 
If you don’t want to overwrite the original file, save the file to a different 
name, location, or both. The selected content is permanently removed 
when you save the file. If you close the file without saving it, you must 
repeat this process, making sure to save the file.  

B. Steps for Acrobat X/XI:  Click the Tools button  Protection  click either Remove 
Hidden Information (which shows you what it finds and gives you an opportunity 
to keep some of it) or Sanitize Document (which removes everything without 
asking you). 

C. Steps for Acrobat DC:  Click the Redact tool  click either Remove Hidden 
Information (which shows you what it finds and gives you an opportunity to keep 
some of it) or Sanitize Document (which removes everything without asking you).  

XVI. COMBINING PDFS: There are two ways to combine PDFs:  1) create one long PDF from 
multiple PDFs, or 2) create a PDF Portfolio (Acrobat v9+).  Portfolios are not one long PDF.  
Instead, they're PDFs which contain multiple other files and those component files retain 
their uniqueness and are not merged together. With Portfolios, they can be many 
different file types including Word, Excel, photographs (JPG files) and the like.   

A. Merge Files Into a Single PDF: The first thing to be aware of is that you don't have 
to feed Acrobat all PDFs in order to merge files into a single PDF.  In other words, 
you could have a Word file, an Excel spreadsheet and a PDF.  Acrobat will convert 
the non-PDF files into PDFs before merging them into a single PDF file.  To do this 
in Acrobat 9, simply click the Combine button  Merge Files into a Single PDF. 

 

In Acrobat X/XI, click the Create button  Combine Files into a Single PDF. 
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In Acrobat DC, click the File menu  Create  Combine Files Into A Single PDF.  
You can also do this using the Combine Files tool for this. 

B. PDF Portfolios: 

1. What They Are: A PDF Portfolio contains multiple files assembled into an 
integrated PDF unit (a single PDF file). The files contained within a PDF 
Portfolio can be in a wide variety of file types from text documents (i.e., 
Microsoft Word), e-mail messages, spreadsheets, CAD drawings, and 
PowerPoint presentations. The original files retain their characteristics as 
separate files but are compressed into a single PDF Portfolio file. You can 
open, read, edit, and format each component file independently of the 
other component files in the PDF Portfolio. This feature is available from 
within Acrobat Professional only and didn't exist at all prior to version 9.   

2. Benefits of PDF Portfolios: You can view the component PDFs like pages in 
a book and quickly flip between them by using the built-in navigation tools 
which appear when you open one.  Furthermore, they can be sorted, 
printed independently and searched.  Any common type of document can 
be included in a Portfolio (not just PDFs).  Therefore, it is a fantastic way to 
pull together many disparate electronic items into one container.   

3. How To Create a PDF Portfolio in Acrobat 9: To create a Portfolio, follow 
these steps: 

a. In Acrobat 9, click the Combine button  Assemble PDF Portfolio 
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b. In the next screen, click Add Files, Add Existing Folder or Create 
New Folder and choose the files you want to include. 

 

c. Now choose a Basic Layout: 

 



Page 55 

d. Choose a Welcome Page or Header: 

 

e. Select a color scheme (or make one). 

f. In order to get the files in the order you want, you'll need to add a 
column in the Specify File Details screen.  I typically make one called 
Index and then number the files so they'll appear in the order I 
want. 
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g. Finally, Publish! 

 

4. How to Create a PDF Portfolio in Acrobat X and XI: 

a. Click the Create button  PDF Portfolio 
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b. Choose a layout (try Click-Through); and click the Add Files button 
in the same dialog.  Browse to and select the files you want to 
include. 

 

c. Now pick a Visual Theme & Color Palette: 
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d. Tweak the Background if you like: 

  

e. Finally, you can change the font if you'd like: 

 

f. To control the order the files appear, click the Details button and 
you can drag them into position (top = left). 

g. Click File menu  Save Portfolio and you're done! 

5. How To Create a PDF Portfolio in Acrobat DC:  First of all, all of the fancy 
options shown above in prior versions are gone.  You can still create a 
portfolio, but it's a kind of plain vanilla version.  However, I find them easier 
to navigate.  Anyway, to create one, just click the File menu  Create  
PDF Portfolio.  Add your files and click the Create button. 
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XVII. DIGITAL SIGNATURES: 

A. What They Are: This is unquestionably one of the most confusing topics I’ve ever 
encountered in legal technology, mostly because any explanation of it is techno-
babble overload.  So I can’t avoid all of the techno-speak when explaining it, but 
I’ll try to limit this to what you need to know. 

A digital signature is like a conventional handwritten signature in that it identifies 
the person signing a document. Key benefits of digital signatures are: 

1. Unlike a handwritten signature, a digital signature is difficult to forge 
because it contains encrypted information that is unique to the signer. 

2. Recipients can easily verify the authenticity of the digital signature (you 
simply click on the signature in a PDF to verify it). 

3. Once digitally signed, neither the signature nor the document signed can 
be altered without detection. 

4. Digital signatures are legally binding in the U.S. so an electronic signer 
cannot later deny responsibility or that they actually signed the electronic 
document. 

B. Digital Signatures Are Not Electronic Signatures: Digital signatures are created 
and verified by cryptography, the branch of applied mathematics that concerns 
itself with transforming messages into seemingly unintelligible forms and back 
again.  The technology behind digital signatures is an industry standard known as 
Public Key Infrastructure (PKI), which guarantees data integrity and non-
repudiation of transactions. The digital signature cannot be copied, tampered or 
altered. On the other hand, Electronic signatures are electronic images that are 
physically or logically attached to the signed data (see paragraph XII. on page 42 
above). Adding a sentence "I, Barron Henley, sign this document" is good enough 
to be considered as an electronic signature; however, it is clear that electronic 
signatures are easy to forge, unlike digital signatures. 

C. How They Work: The American Bar Association Section of Science and Technology 
Information Security Committee has released a Digital Signature Guidelines 
Tutorial which you can buy for $35 here: http://tinyurl.com/7x2q2dz.  It contains 
an excellent, but technical, explanation of digital signatures, how they work and 
what is involved.  Another good explanation can be found here for free:  
http://youdzone.com/signature.html.   

D. How You Obtain a Digital Signature: You can create your own using Adobe 
Acrobat.  See http://tinyurl.com/2u9hrh for instructions for this.  In the 
alternative, you can use a third party, some of which verify your identity 

http://tinyurl.com/2u9hrh
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beforehand.  For a list of Adobe approved vendors, see http://tinyurl.com/2jd9cf.  
You can also find plenty of options if you google ["digital signature" pdf].   

XVIII. BOOKMARKS AND LINKS IN PDFS FOR QUICK NAVIGATION: 

A. Creating Bookmarks: You can create bookmarks in your PDFs for quick navigation.   

1. First, open your PDF.  Hit F4 to open the Navigation Pane and you'll see an 
icon for bookmarks.  Just click on it to reveal the bookmarks in your 

document (if any).  The bookmarks button looks like this:   

2. Select the text in the document you’d like to create a bookmark for.  Right-
click it, then choose Add Bookmark.  

3. Name the bookmark and you’re done.  You can now navigate back to that 
spot by click the bookmark name in the Bookmark panel on the left side of 
the document. 

B. Bookmark Customizations:  Here are a couple of things about bookmarks you 
might find useful. 

1. Change the Order of Bookmarks:  If your bookmarks aren't in the order 
you want in the bookmark pane, simply hold down on your left mouse 
button and you can drag them into the correct position. 

2. Change the Format of the Bookmark Link:  You can also make a bookmark 
bold, italic or bold & italic.  By default, they're "plain."   

C. Making Bookmarks Visible Immediately Upon Opening a PDF:  If you want the 
bookmarks to be visible when the judge or someone else opens your brief, follow 
these steps: 

http://tinyurl.com/2jd9cf
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1. Click on File menu  Properties. 

 

2. Click on the Initial View tab. 

3. Choose Bookmarks Panel and Page 

4. Click OK. 

D. Other Controls for the Initial View:  Also note that you can control the initial page 
layout, magnification and what page a PDF opens to. 

E. Creating Links to Bookmarks: Now that you’ve created a bookmark, you might 
want to create hyperlinks to it from other text in your PDF.  In order to do this, 
follow these steps: 

1. Select the text you’d like to link to a bookmark in your PDF, right click it 
and choose Create Link. 

2. Switch your link type to Invisible Rectangle unless you want the box to be 
visible in your PDF.  Leave the Link Action on "Go to a page view" and click 
Next. 
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3. Now click on the name of the Bookmark in the Bookmark panel that you 
want to link to; then click Set Link. 

 

4. You’re done.  Test it to make sure it works. 

XIX. REDUCING PDF FILE SIZE:  If you create PDFs that are too big (in terms of bytes), it will 
make it difficult for people to download or work with them.  Therefore, it's important that 
you understand how to create smaller PDFs initially and how to shrink existing PDFs. 

A. From Your Word Processor – Creating Smaller PDFs: When printing to PDF, click 
on the Properties button.  Now click the Adobe PDF Settings tab and under 
Default Settings, choose Smallest File Size, then click OK at the bottom of the 
dialog.  Now finish creating your PDF. 
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B. From a Scanner:  File size when you scan a document to a PDF is impacted by three 
things:  1) color mode, 2) dpi and 3) number of pages.   

1. Color Mode:  Most scanners will allow you to scan in color, black and white 
or grayscale.  Even if the document you're scanning has no color in it, the 
resulting scanned document will be very large if you scan with color mode 
set to color.  The same thing is true with grayscale.  To keep file size small, 
you want your scanner's color mode set to black and white. 

2. DPI:  DPI stands for dots per inch and this is the resolution your scanner is 
set to.  The higher the dpi, the better the quality.  However, as you increase 
dpi, you also increase file size.  Most scanners can scan from 100 to 1,200 
dpi.  Generally, the best balance between quality and file size is 300 dpi. 

3. Number of Pages:  Obviously, the more pages you scan, the bigger the 
resulting file size.  If you scan at 300 dpi black and white and the file is still 
too large, then there are still ways to reduce the file size as described 
below. 

C. Shrinking the File Size of an Existing PDF in Acrobat 8/9:  There are two easy ways 
to reduce the size of an existing PDF, both of which are accessed under the 
Document menu in Acrobat 8 and 9. 

1. Reduce File Size Option: Click Document menu  Reduce File Size.  This 
command resamples and recompresses images, removes embedded fonts, 
compresses document structure, and cleans up elements such as invalid 
bookmarks. In the drop-down adjacent to "Compatible with:", choose 
Acrobat 6.0 and later unless you’re certain someone will be trying to open 
it using an earlier version.  If you’re certain that everyone accessing the 
PDF will be using Acrobat 7 or later, then choose that. 
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NOTES: 

• If the file size is already as small as possible, this command has no 
effect.  

• Reducing the file size of a digitally signed document removes the 
signature. 

2. Optimizing Scanned PDF Option: Scanned documents can often be made 
much smaller.  The Optimization Options dialog box for image settings 
controls how scanned images are filtered and compressed for the PDF. 
Default settings are suitable for a wide range of document pages, but you 
can also customize the settings for higher quality images, smaller file sizes, 
or other scanning issues.  Just open the PDF you want to optimize, click the 
Document menu  Optimize Scanned PDF. 

D. Shrinking the File Size of an Existing PDF in Acrobat X/XI: 

1. Reduced Size PDF:  Open the PDF you want to shrink  File menu  Save 
As  Reduced Size PDF  choose compatibility  OK. 

2. Optimizing Scanned PDF:  This is the same option outlined above for 
Acrobat 8 and 9.  You get to it by clicking the Tools button  Document 
Processing  Optimize Scanned PDF. 

E. Shrinking the File Size of an Existing PDF in Acrobat DC: 

1. Reduced Size PDF:  Open the PDF you want to shrink  File menu  Save 
As Other  Reduced Size PDF  choose compatibility (recommend version 
7)  OK. 

2. Optimizing Scanned PDF:  Open the PDF you want to optimize  File menu 
 Save As Other  Optimized PDF. 
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F. Splitting PDFs That Are Too Large:  

1. Determine the Size of Your PDF: First, you need to determine how big your 
PDF is.  In order to do that, open the PDF in Acrobat, click the File menu  
Properties  Description tab and you’ll see a File Size listed under 
Advanced. 

 

Some courts require that PDFs are less than 2 megabytes so if your PDF is 
larger than that, you may have to split it in order to get each piece below 
the 2 MB threshold.   

2. Method with Acrobat 9: To perform the foregoing exercise of splitting a 
311 page file, just click the Document menu  Split Document. 

 

As you can see, you can split by pages, file size or bookmarks.  By default, 
Acrobat will not touch your original file, but will create new files 
representing the pieces of your large document in the same folder where 
the original document is stored.  Since my original document was called 
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2009-01-12 - OfficeKeeper Master, Acrobat created the two additional files 
you see below. 

 

3. Method with Acrobat X/XI:  Click the Tools button  Pages  Split 
Document. 

4. Method With Acrobat DC:  Open the Organize Pages tool from the Tools 
Pane  Split button. 

XX. ADDING, REMOVING, REPLACING PDF PAGES IN ACROBAT:  You can manipulate PDFs 
easily in Acrobat through the Task Pane or through the Thumbnail View in the Navigation 
Pane.   

A. Manipulations via Thumbnails in the Navigation Pane: If you have a document 
management system like Worldox, saving/profiling each document temporarily 
just to insert it into another document can be very time consuming!  Instead, just 
open each PDF and turn on the Thumbnail View by clicking on the thumbnail icon 
located in the Navigation Pane on the left.  From the thumbnail view, you can 
delete, move, replace, and extract pages. 
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B. Adding Pages in Thumbnail View: Open each PDF and turn on the thumbnail view 
for each PDF.  Drag one or more pages from one PDF into the other PDF. 

 

C. Adding Whole PDFs in Thumbnail View: Open the destination PDF and turn on 
the thumbnail view.  Drag the entire PDF into the desired location.  You can drag 
from the desktop or any folder/file location. 

 

Moving Pages in Thumbnail View: Open the PDF and turn on the Thumbnail View.  
Drag the desired page(s) from one spot in the Thumbnail View to the desired 
location. 
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Manipulations in the Task Pane: In Acrobat X/XI, you find these options under 
Tools button  Pages.  In Acrobat DC, open the Organize Pages tool from the Tools 
pane.  This is what the tools look like in Acrobat X/XI: 
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This is what the tools look like in Acrobat DC: 

 

XXI. WATERMARKS:  You can add a watermark to a PDF easily in Acrobat.   

A. What Is a Watermark?  Traditionally, a watermark was a translucent mark in 
paper, produced by the pressing of a projecting design, as in the mold, during 
manufacture.6  Today, watermarks typically have little to do with the 
manufacturing process of the paper.  Instead, they are usually printed on the 
paper but are so faint that you can easily read the text of the document over them.  
Acrobat's watermark feature is an overlay on your document. 

B. Steps for Creating a Watermark in Acrobat:  Just follow these steps to create a 
watermark on a document: 

1. In Acrobat 9, click the Document Menu  Watermark  Add.  In Acrobat 
X/XI, click the Tools button  Pages  Watermark  Add Watermark.  In 

                                                      
6 See http://www.yourdictionary.com/watermark 
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Acrobat DC, open the Edit PDF tool from the Tools pane  Watermark 
button  Add. 

 

2. Type the text of the watermark you want (Draft, for example) 

3. Recommended settings: 

a. 45° rotation 

b. 25% opacity 

c. Scale relative to target page: 100% 

d. Location:  Appear on top of page 

C. Saving Your Watermark:  After you have crafted your watermark, click the Save 
Settings button at the top of the dialog so you don't have to go through all of those 
settings again the next time you want to use the same dialog. 
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D. Appearance Options:  On the Watermark dialog, you'll see a blue hyperlink for 
Appearance Options.  As you can see below, this gives you the option of making 
the watermark only appear when someone tries to print the document. 

 

E. Page Range Options:  On the top, right-hand corner of the Watermark dialog, 
you'll see a Page Range Options link.  Clicking it will give you the option of making 
the watermark apply to all pages, only a certain page range or even or odd pages 
only. 

XXII. FILLABLE PDF FORMS:  Acrobat has a wonderful tool for creating fillable PDF forms you 
can distribute to others (this feature is available in Acrobat Standard and Professional 
versions 9, X, XI & DC).   

A. Examples: 

1. Client Intake Forms 

2. Expense Reimbursement Forms 

3. Court Forms not already available in PDF format 

B. Drafting the Background Form: You first need to create the background form by 
either (1) creating it in a program like Microsoft Word or Publisher and saving it as 
a PDF, or (2) scanning it and saving it as a PDF. 

You will get a much cleaner and crisper quality document if it is re-created 
electronically in Word or Publisher and then you print/save it as a PDF. 

Once you have the underlying document converted to PDF, you will be ready to 
add the form fields in Adobe Acrobat. 
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C. Run Form Field Recognition: 

1. Steps Using Acrobat 9:  First, open the PDF you want to convert into a 
fillable form. 

a. Once the PDF is open in Acrobat, click the Forms menu  Start 
Form Wizard. 

b. Choose the appropriate starting point from the next dialog  Next. 

 

c. Use the current document if it's open; otherwise import it. 
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d. Save the form and voila! 

 

2. Steps Using Acrobat X/XI: 

a. Click Tools button  Forms  Create. 

b. In the next dialog, choose "Use an existing file" or Scan a paper 
form  Next. 
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c. If you choose "Use an existing file", the next dialog will ask you 
whether you want to use the current document or import a file.  
Choose Use current document  Next. 

d. Your form should now be fillable. 

3. This process will find most text fields on your form.  If it doesn't you can 
add fields yourself. 

4. Once your form has been "recognized," click the Preview button to see 
how it looks and test it.  To go back to edit mode, just click the Edit Layout 
button. 

D. Steps Using Acrobat DC:  Open the form you want to make fillable  open the 
Prepare Form tool from the Tools screen or the Tools pane  Start button.  That's 
it.  Once your form has been "recognized," click the Preview button to see how it 
looks and test it.  To go back to edit mode, just click the Edit Layout button. 

E. Clean Up The Form: 

1. Fixing Check Boxes: The form wizard will locate check boxes on a form and 
make them fields.  However, they are usually set up as separate fields 
which means you can check them all at once.  That may be fine in some 
cases, but other times the options are mutually exclusive.  For example, if 
you had a section of your form that looks like the following, you wouldn’t 
want users to have the option of checking both boxes: 

 

In my form, the foregoing boxes were recognized by the form wizard as 
separate check boxes so the user would be able to check both of them.  To 
eliminate this as a possibility, just follow these steps: 

a. Remove the Existing Client field by clicking on it, then hitting your 
delete key. 

b. First, zoom in so you can better see what you’re doing.  I like 300% 
zoom when I’m doing tight editing like this.  Double click the New 
Client field to get to its properties. 

c. Click on the Options tab and switch the Check Box Style from 
square (unless you like that) to Check; and change the Export Value 
from "on" to "True". 
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d. Under the Appearance tab, change the Border Color and Fill Color 
to "no color" 

 

e. Click the Close button at the bottom. 

f. Next, I would change the field dimensions so it evenly overlaps the 
borders of the checkbox.  It would go from this: 

 

To this: 
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g. Now click on the field you just modified and hit Ctrl+C (copy) then 
Ctrl+V (paste).  Somewhere on the screen, a duplicate of the New 
Client field will appear.  Drag it over the Existing Client checkbox. 

h. Double click the 2nd field to get to the Properties dialog.  Click the 
Options tab and change the Export Value to false. 

i. Now Click the Preview button at the top left corner of the screen 
and test the boxes to make sure they’re mutually exclusive. 

2. Fix Tab Order: The Tab Order is the sequence in which your cursor moves 
from field to field when you hit the tab key on your keyboard.  Manually 
adding fields like we did in the preceding step can mess this up.  In order 
to fix it, first click the Forms menu  Edit Fields  Show Tab Numbers.  
Next, you’ll see this: 

 

Click OK.  On the left side of your screen, the fields appear in the tab order.  
If you want to change it, just drag a field to another location from top to 
bottom and you’ll see that its tab number will change appropriately. 
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3. Format Fields Properly: Acrobat will not guess exactly how you want 
things formatted.  Scan you form and if you see a field that needs to have 
specific formatting, double click it, click the Format tab and make the 
appropriate adjustment. 

 

4. Name Fields Properly: Acrobat looks at the text of the form to guess what 
fields should be called and it isn’t always right.  If you see any fields that 
do not have useful names, double click them and rename as appropriate. 

 

F. Add SAVE functionality in Acrobat Reader: IMPORTANT – Unless you "distribute" 
the form as indicated below (which often times isn’t desirable), you must embed 
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save rights (or "extend" save rights) into the PDF.  If you do not, your users trying 
to fill out the form in Reader (like your clients, etc.) will receive this error: 

 

To "extend" save rights, select File > Save As > Reader Extended PDF > Enable 
Additional Features. 

 

You will receive the following confirmation: 
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G. Add A Submit Button To Your Form: Your form can be distributed to recipients 
via email and the answers they supply to the form can be emailed back to you 
(rather than the form itself).  Once you receive the answers, the form can be re-
assembled and Acrobat will even store the information you receive in a database.  
To create the submit button, follow these steps: 

1. In Acrobat 9, click the Add New Field button at the top left corner of the 
screen and choose Button.  In Acrobat X, click Add New Field under Tasks 
(right side of screen)  Button.  Now position the button where you’d like 
and name it: 

 

2. Double click the button you’ve made and the Button Properties dialog will 
appear.  On the Appearance tab, I’d recommend the following settings: 
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3. On the Options tab, give the button a label. 
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4. On the Actions tab, select the "Mouse Up" trigger, select the "Submit a 
form" action and click the Add button. 

 

5. When you click Add, you’ll see the following dialog. In the top field, type 
mailto: and then your email address (no spaces).  You might want to check 
the "convert dates to standard format" as well.  If you want to make the 
incoming forms easy to deal with, then choose "PDF the complete 
document" below rather than "FDF Include" which is the default. 

 

6. Now click the OK button, then the Close button at the bottom of the dialog. 
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7. Click the  button on the Forms toolbar to see how your form 
will look. 

H. Distribute Your Form Using Acrobat X/XI: Now your form is ready to be emailed 
to recipients.  Just follow these steps: 

1. Open the form in Acrobat. 

2. In Acrobat X/XI, click the Forms menu  Distribute Form.  Now you’ll see 
the following dialog.  Under "How do you want to collect…", choose 
"Manually collect…" and click the Next button. 
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3. Follow the subsequent on-screen instructions to distribute your form.  
When the forms come back via email, they’ll automatically compile 
themselves into a database Acrobat sets up for you. 

I. Distribute Your Form Using Acrobat DC:   

1. In Acrobat DC, click the Distribute button at the bottom of the Prepare 
Form pane.  Next you'll see the following screen.  Choose email  Continue 
button. 

 

2. Next, determine how you want to distribute the form.  You can send it 
using Adobe Acrobat DC or save a local copy and manually send it later. 
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XXIII. BATES NUMBERING:  Adobe Acrobat Professional version 8 added excellent Bates 
numbering functionality for the legal profession.  No longer will one need a 3rd party tool 
to do Bates numbering.  Bates numbering is a method of indexing legal documents for 
easy identification and retrieval. Bates numbers appear as headers or footers on the 
pages of each PDF in the batch. It can include an alphanumeric prefix and suffix, which 
can make it easier to recognize the central subject matter of the files.  

Adding Bates numbering does not change the file names of the PDFs, rearrange them in 
desktop folders, link them, or add them to a collection in the Organizer. The only way you 
can tell that Bates numbering has been added is by opening the PDF and looking at the 
headers and footers, or by printing the document.   

A. Adding Bates Numbering to PDFs: Follow these steps: 

1. You do not need to open each PDF in order to apply Bates numbering.  
Place the PDFs in a single folder (for ease), or note each PDF's location on 
your computer. 

2. In Acrobat 8 and 9, click the Advanced menu  Document Processing  
Bates Numbering  Add.  In Acrobat X/XI, click the Tools button  Pages 
 Bates Numbering  Add Bates Numbering.  In Acrobat DC, click the 
Stamp tool in the Tools pane  Bates Numbering button. 

3. Click Browse and select all the desired PDFs in Acrobat 8 or 9.  In Acrobat 
X/XI/DC, click the Add Files button in the top, left corner. 

4. Adjust the order of the list as needed by simply dragging the PDF to the 
desired position, or select the PDF and click Move Up or Move Down. 

5. To remove an unwanted PDF, simply select it and click Remove. 

6. Click Next and then the Add Footer/Add Header dialog box will appear. 

7. Click inside the desired location (Header or Footer) (Left, Center or Right). 
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8. Click Insert Bates Number. 

a. Number of Digits:  (padding)  specify the number of digits that make 
up the Bates number.  The minimum is 6 and the maximum is 15. 

b. Start Number:  Enter the number that will be assigned to the first 
page of the first PDF. 

c. Prefix:  Any text to appear before the Bates number. 

d. Suffix:  Any text to appear after the Bates number. 

B. Add More Documents to a Bates Numbered Series: 

1. On the menu bar, select Advanced and then Document Processing. 

2. Next, select Bates Numbering and Add. 

3. Click Browse and select all the desired PDFs to add. 

4. Click Next and then the Add Footer/Add Header dialog box will appear. 

5. Click Insert Bates Number. 

6. Type the suffix and prefix that matches the rest of the series. 

7. Type the next number in the series in the Start Number field. 

8. Click OK.  

9. Adjust the order of the list as needed by simply dragging the PDF to the 
desired position, or select the PDF and click Move Up or Move Down. 
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C. Add Avoid Overwriting Graphics with Bates Numbers:  To avoid having the Bates 
number being stamped on top of existing graphics, select Appearance Options  
Shrink document to avoid overwriting document’s text and graphics. Click OK. 
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XXIV. REDACTING TEXT:  Note about saving redacted files ** REDACTIONS ARE PERMANENT!! 
**  Redactions are permanent once applied.  Do not save the redacted version of the PDF 
over the original.  Always make sure to save the redacted version as a separate file.  As a 
further safeguard, check the "Adjust filename when saving applied redaction marks" 
options in EditPreferencesDocuments: 

 

A. Redacting In A PDF: To permanently obscure text in a PDF, follow these steps.  
However, you should always make a backup copy of the PDF you’re working with 
because redactions are permanent and cannot be reversed once complete.  
Follow these steps: 

1. Open the desired PDF. 

2. In Acrobat 8 and 9 Professional, turn in the Redacting Toolbar by selecting 
from the menu bar Advanced and Redaction.  The following toolbar will 
appear: 
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In Acrobat X/XI Professional, click the Tools button  Protection. 

In Acrobat DC, click the Redact tool from the Tools pane. 

3. To redact text in a text-searchable PDF, simply click on the Mark for 
Redaction button, select the desired text, as represented by the smaller 
red rectangle below, and then click Apply Redactions. 

4. To redact a region or area (images or non text-searchable PDF), simply click 
and drag over an area, as represented in the larger red rectangle below, 
and then click Apply Redactions. 

5. When you save the document, you will be asked to save the document 
with a different name. 

6. The default redaction color is black.  To change this, click on the Redaction 
Properties toolbar button. 

7. To Search and Redact, click on the Search and Redact button in Acrobat 9.  
In Acrobat X/XI, click Search & Remove Text.  In Acrobat DC, click the Mark 
for Redaction button  Find Text.  Perform a search for the desired text, 
phrase or pattern.  Select the results you would like to mark by checking 
the boxes to the left of the result list.  Then select Mark for Redaction.   
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B. Only Available in Acrobat Professional Version 8, 9, X, XI & DC:  This particular 
feature is not available in Adobe Acrobat Standard – only Professional and not in 
any prior versions. 

C. Acrobat’s Eraser: In Acrobat 8 or 9, if you click the Advanced menu  Redaction 
 Redaction Properties (see below), you can change the Redacted Area Fill Color 
to No Color.  Assuming the background of your PDF is white, this will effectively 
erase whatever you redact (in other words, it won’t black it out). 

 



Page 90 

 

You can get to the same menu in Acrobat X/XI by clicking the Tools button  
Protection  Redaction Properties.  In Acrobat DC, click the Redact tool  
Properties button. 

D. Using Comments with Redaction. Every redaction generates a comment.  
However, the comment does not include the redacted text by default.  To change 
this setting, go to EditPreferencesComments and check "Copy selected text 
into Highlight, Strikethrough, and Underline comment pop-ups. 
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You can then create a summary of all the redacted text by creating a comment 
summary. 

To create a privilege log across multiple documents, download the free Action 
"Create Comment Summary" for Acrobat X/XI from: 

https://acrobatusers.com/assets/uploads/actions/Create_Comment_Summary.sequ 

This action will create a spreadsheet of all comments from multiple documents.  
Note:  The generated spreadsheet will not include the redaction codes. 

https://acrobatusers.com/assets/uploads/actions/Create_Comment_Summary.sequ
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Exhibit A 
Adobe Acrobat DC Features Matrix 

 



Page 93 

Exhibit B 
Adobe Acrobat Version Comparison 

 

 


